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Experiment HP-3: Interference of Stimuli on Associative Tasks - The Stroop Effect

Background
In his doctoral thesis published in 1935, J.R. Stroop reported that the completion of a task could be 
strongly influenced by stimuli from another task to which it is associated. In his work, Stroop found 
that a subject’s ability to read words was influenced by the color in which the words were printed. 
Likewise, the subject’s ability to name the colors in which the words were printed was influenced by 
the actual words. Each task, naming colors and reading words, received interference from stimuli 
associated with the other task. 

Stroop conducted tests in which subjects were asked to read words that identify specific colors, 
however, the words were printed in a color that was different than the color identified by the word. For 
example, when the word “Green” was printed with blue ink, the subject was asked to read the word 
“Green”. When compared to the control task of reading color words printed in black, the increase in the
time taken by the subject to react to words printed in conflicting colors was an indication of the 
interference of color stimuli on the task of reading words. Stroop also proposed the strength of the 
interference was an indication of the strength of the association between the two tasks.

In another test, subjects were asked to name the conflicting color in which the color word was printed. 
For example, the word “Red” was printed in green and the subject was asked to name the color 
“Green”. When compared to the control task of naming the colors in which the same nondescript 
symbol was printed, the increase in the time taken by the subject to react to the colors of conflicting 
words was an indication of the interference of word stimuli on the task of naming colors. Go to the 
fourth column on Table HP-3-B1 and name the colors in which the words are printed. It’s not that easy, 
is it? Through your experience, you have been taught that the meaning of a word is more important 
than the color in which it is printed. When you try to pay attention to a color and name it, the word 
stimuli interferes with the task.

In this experiment, subjects will perform tasks that demonstrate the Stroop Effect in several different 
ways: the effect of word stimuli on color naming, the effect of color stimuli on reading words, the 
effect of word stimuli on naming directions, and stimuli of your own choice or design. The completion 
time of each task will be used as an indicator of the strength of the interference of the stimuli on the 
task; Stroop correlated longer completion times to higher degrees of interference. 

Since these tasks are also stressors, the heart rate and skin conductance level of each subject will be 
recorded before, during, and after each task (Figure HP-3-B1). Do you think the stress indicators will 
correlate to the level of interference during a task?

An interesting variant of this is to compare certain groups of people in how well they do. Bi-lingual 
people may do better or worse. For those with ADD, this test is extremely difficult, for unknown 
reasons. fMRIs show that people with ADD use a completely different part of the brain when doing this
test. Left-handers vs right-handers is another interesting comparison that has shown a degree of 
difference in success. 

Human Psychophysiology – StroopEffect HP-3-1



iW
or

x S
am

ple
 La

b

Figure HP-3-B1: Pulse, skin conductance level (SCL), and heart rate of subject performing the task of 
reciting the names of colors printed in black. During the task, the subject’s skin conductance level 
increased by 1.83%.

Table HP-3-B1: Sample lists of colored words used in Exercises 1 and 2 of “The Stroop Effect”.

Task1 Task 2 Task 3 Task 4

BLUE BLUE XXXX RED

GREEN GREEN XXXX BLUE

RED BLACK XXXX GREEN

GREEN BLUE XXXX BLUE

RED GREEN XXXX BLACK

RED RED XXXX BLUE

BLUE GREEN XXXX GREEN

GREEN RED XXXX RED

BLUE BLUE XXXX GREEN

BLACK BLACK XXXX RED

Human Psychophysiology – StroopEffect HP-3-2
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Experiment HP-3: Interference of Stimuli on Associative Tasks - The Stroop Effect

Equipment Required
PC or Mac Computer

USB cable

IX-B3G USB recorder

GSR electrodes

Three ECG electrode leads

Disposable ECG electrodes

Alcohol swabs

Tables of words and symbols

IX-B3G Setup
Use the USB cable to connect the computer to the USB port on the IX-B3G. 

Start the Software
1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IXB3G.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the StroopEffect settings file from Human 
Psychophysiology.

5. After a short time, LabScribe will appear on the computer screen as configured by the 
StroopEffect settings.

6. For your information, the settings used to configure the LabScribe software and the IX-B3G 
unit for this experiment  are programmed on the Preferences Dialog window which can be 
viewed by selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 
of the following documents:

• Appendix
• Background
• Labs
• Setup (opens automatically)

Human Psychophysiology – StroopEffect HP-3-3
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 GSR and ECG Setup
1. Connect the GSR electrodes to the IX-B3G (Figure HP-  3  -S1). Connect the purple color-coded 

electrode to the purple connector on the IX-B3G and the orange electrode to the orange 
connector. 

2. Insert the connectors on the red, black, and green ECG electrode lead wires into the matching 
sockets on the IX-B3G (Figure HP-3-S1).

3. Instruct the subject to remove all jewelry from their wrists and ankles.  Another option is to use 
the area just under each clavicle which will give a better recording.

4. Use an alcohol swab to clean and scrub a region with little or no hair, on the inside of the 
subject’s right wrist/clavicle. Let the area dry.

5. Remove a disposable ECG electrode from its plastic shield, and apply the electrode to the 
scrubbed area on the wrist or under the clavicle.

6. Repeat Steps 6 and 7 for the inside of the left wrist/clavicle and the inside of the right ankle or 
lower right abdomen.

Figure HP-3-S1: The iWire-B3G with GSR electrodes and three ECG lead wires attached.

7. Snap the lead wires onto the electrodes, so that:

• the red (+1) lead is attached to the left wrist or just under the left clavicle,

• the black (-1) lead is connected to the right wrist or just under the right clavicle,

• the green (C or ground) lead is connected to the right leg or on the abdomen.

8. Instruct the subject to sit quietly with their hands in their lap. If the subject moves, the ECG 
trace will move off the top or bottom of the screen. If the subject moves any muscles in the 
arms or upper body, electromyograms (EMGs) from the muscles will appear on the ECG 
recording as noise.
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Calibration of GSR Amplifier
1. Place the GSR electrodes on the lab bench so they are not touching any surfaces.

2. Click on the Record button; record data for 1 minute.

3. Click on the Stop button.

4. Set the baseline to zero:

• Click the down arrow to the left of the GSR channel to open the Channel Menu.

• Click Units 

• Click Set Offset (Figure HP-3-S2)

• Set the offset to 0 and check Apply to all blocks 

• Click OK.

Figure HP-3-S2: Apply Offset window for setting the GSR unit to “0”.
Note: If the user clicks the Record button and an error window appears the Main window indicating 
the iWorx hardware cannot be found, make sure the iWorx unit is connected to the USB port of the 
computer. Then, click on the OK button in the error window. Pull down the LabScribe Tools menu, 
select the Find Hardware function, and follow the directions on the Find Hardware dialogue window

Note: The iWire-B3G galvanic skin response amplifier is factory calibrated so that an output of 1 Volt 
is equal to 1 microSiemen (µS). This calibration factor is programmed into the LabScribe recording 
software by the settings file used in this experiment. 

5. To check the programming of the calibration:

• Click on the arrow next to the title of the Skin Conductance Level channel to open the 
channel menu. 

• Select Units from the channel menu and Simple from the Units submenu.

• The Simple Units Calibration window will appear with the values for the two-point 
calibration of the iWire-B3G amplifier already entered.  
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Experiment HP-3: Interference of Stimuli on Associative Tasks - The Stroop Effect

Exercise 1: Interference of Color Stimuli on Reading.
Aim: To determine the effect of the color in which a word is printed on the subject’s ability to read the 
word.

Procedure
1. Select one person from your group to be the subject. Ask the subject to go to the sink, wash his 

or her hands with soap and water, and dry them thoroughly. Washing the hands insures that 
surface oils or other substances, which might lower skin conduction, are removed. Do not use 
alcohol to clean the fingers, alcohol dehydrates the skin.

2. Connect the GSR electrodes. 

3. The subject should sit with his or her back to the computer monitor. Use the subject’s hand 
which is closer to the iWorx equipment. 

4. Attach each GSR electrode to the volar surface of the distal finger segment of two non-adjacent 
fingers; the index and the ring fingers are the ones usually used. Attach the electrodes with the 
Velcro straps so that the straps are snug, but not overly tight.

5. The subject should rest the hand with the GSR electrodes comfortably in his or her lap. The 
electrodes and transducer should be free from any extraneous pressure and their cables should 
be hanging freely. Instruct the subject not to move the hand during the recording process; 
movement will introduce artifacts into the recording. 

6. Type Task 1: Read Words in Black, <Subject’s Name> in the Mark box that is to the right of the
Mark button.

7. Click on the Record button, located on the upper right side of the LabScribe Main window 
(Figure HP-  3  -L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the iWorx unit and 
computer, an error window will appear in the center of the Main window. Make sure the iWorx unit is  
connected to the USB port of the computer. Click OK and select the Find Hardware function from the 
LabScribe Tools menu. 

8. Click on the AutoScale All button in the LabScribe toolbar. The signals on these channels 
should expand to fill the channel windows.

• If the ECG signal is upside down when compared to the trace in the figure, click on the 
downward arrow to the left of the channel title and select the Invert function. The trace should 
now look similar to the one in the figure.

• If a larger ECG signal is required, the electrodes should be moved from the wrists to the skin 
immediately below each clavicle. 

9. Record until the skin conductance level of the subject, recorded on the Skin Conductance Level 
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channel has reached a stable baseline.

Figure HP-3-L1: Skin conductance level (SCL), ECG, and heart rate of subject performing the task of 
reciting the names of colors printed in black. During the task, the subject’s skin conductance level 
increased.

10. Instruct the subject to read the words in the first column of Table HP-  3  -L1 aloud, and as quickly
as possible. Press the Enter key on the keyboard as soon as the subject begins reading the list. 

11. Type End of First Column in the Mark box.

12. Press the Enter key on the keyboard as soon as the subject has read the last word in the first 
column. Continue to record.

13. While the subject relaxes for 1 to 2 minutes, type Task 2: Read Words in Conflicting Colors in 
the Mark box.

14. Instruct the subject to read the words in the second column of Table HP-  3  -L1 aloud, and as 
quickly as possible. Press the Enter key on the keyboard as soon as the subject begins reading 
the list. 

15. Type End of Second Column in the Mark box.

16. Press the Enter key on the keyboard as soon as the subject has read the last word in the second 
column. Continue to record as the subject relaxes for a minute.

17. Click Stop to halt the recording.

18. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click 
on the Save button to save the data file. 

Human Psychophysiology – StroopEffect HP-3-7
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19. Begin Exercise 2 after allowing the subject to rest for 1 or 2 minutes.

Exercise 2: Interference of Word Stimuli on Naming.
Aim: To determine the effect of words on the subject’s ability to name the colors in which the words 
are printed.

Procedure
1. While the subject relaxes for 1 to 2 minutes, type Task 3: Name Color of Symbols in the Mark 

box.

2. Instruct the subject to say the colors of the symbols in the third column of Table HP-  3  -L1 aloud,
and as quickly as possible. Press the Enter key on the keyboard as soon as the subject begins 
saying the colors. 

3. Type End of Third Column in the Mark box.

4. Press the Enter key on the keyboard as soon as the subject has read the last word in the third 
column. Continue to record.

5. While the subject relaxes for 1 to 2 minutes, type Task 4: Name Color of Conflicting Words in 
the Mark box.

6. Instruct the subject to read the words in the fourth column of Table HP-  3  -L1 aloud, and as 
quickly as possible. Press the Enter key on the keyboard as soon as the subject begins reading 
the list. 

7. Type End of Fourth Column in the Mark box.

8. Press the Enter key on the keyboard as soon as the subject has read the last word in the fourth 
column. 

9. Continue to record for 1 to 2 minutes.

10. Click Stop to halt the recording.

11. Select Save in the File menu.

Data Analysis: Pre-Task 1
1. Scroll through the data file and locate the recording that was made before Task 1. 

2. Use the Display Time icons to adjust the Display Time of the Main window so that the segment 
before Task 1 can be viewed on the screen.

3. Click the 2-Cursor icon (Figure HP-  3  -L2) so that two vertical lines appear on the Main window.
Use the cursors to select the complete segment before Task 1. This section of data can also be 
selected by:

• Placing the cursors on either side of a stabile recording of the subject’s skin conductance
level and heart rate.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand or 
contract the recording to the width of the Main window.

Human Psychophysiology – StroopEffect HP-3-8
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Figure HP-3-L2: The LabScribe toolbar.

4. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 
transfer the data displayed in the Main window to the Analysis window (Figure HP-  3  -L3).

5. Look at the Function Table that is above the Pulse channel in the Analysis window. The 
mathematical functions, Max, Min, Mean, and T2-T1, should appear in this table. The values 
for these functions are displayed in the tables across the top margins of the channels displayed 
in the Analysis window.

6. Once the cursors are placed in the correct positions for determining the values for these 
functions in a stabile section of the recording, the values can be recorded in the on-line 
notebook of LabScribe by typing the names and values of the functions directly into the Journal.

7. The functions in the channel menu of the Analysis window can also be used to enter the names 
and values of the functions from the recording to the Journal. To use these functions:

• Place the cursors at the locations used to measure the maximum, minimum, and mean 
tonic skin conductance levels and resting heart rates.

• Transfer the names of the functions to the Journal using the Add Title to Journal function
in the Skin Conductance Level channel menu.

• Transfer the values for those functions on all channels to the Journal using the Add All 
Data to Journal function in the Skin Conductance Level channel menu.

8. Use the mouse to click on and drag a cursor to the left margin of the data displayed on the 
Analysis window. Drag the other cursor to the right margin of the same data.

9. Record the values for Max, Min, and Mean on the Skin Conductance Level and Heart Rate 
channels in the Journal using the one of the techniques described in Steps 6 or 7, and on Table 
HP-  3  -L2.

Human Psychophysiology – StroopEffect HP-3-9
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Figure HP-3-L3: Skin conductance level (SCL), ECG, and heart rate data for Task 2 (Words in 
Conflicting Colors), as displayed in the Analysis window. The subject took 20.075 seconds to complete 
this task. During the task, the subject’s SCL rose more than in Task 1.

Data Analysis: Tasks 1, 2, 3, and 4
1. Scroll through the data file and locate the recording that was made during Task 1. 

2. Use the Display Time icons to adjust the Display Time of the Main window so that all data 
recorded during Task 1 can be viewed on the screen.

3. Click the 2-Cursor icon (Figure HP-  3  -L2) so that two blue vertical lines appear on the Main 
window. Use the cursors, or the Zoom between Cursors function, to select the complete set of 
data from Task 1. 

4. Click on the Analysis window icon to transfer the data displayed in the Main window to the 
Analysis window.

5. Place the cursors at the beginning and end of the data recorded during Task 1. Measure the 
values for the following parameters:

• Maximum, MInimum, and Mean Skin Conductance Levels, which are detemined by 
using the Max, Min, and Mean computed functions on the data in the Skin Conductance 
Level channel.

• Maximum, MInimum, and Mean Heart Rate, which are detemined by using the Max, 
Min, and Mean computed functions on the data in the Heart Rate channel.

Human Psychophysiology – StroopEffect HP-3-10
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• Task Completion Time is the time between the first and the last word or color in the task 
being spoken, which is determined by the T2-T1 computed function.

6. Transfer the values for these parameters to the Journal using either of the techniques described 
in the previous analysis section. Record the values for these parameters on Table HP-  3  -L2. 
Calculate the difference between the maximum and minimum skin conductance levels, and the 
maximum and minimum heart rates. Record these values in the Journal, and Table HP-  3  -L2.

7. Repeat Steps 1 through 7 on the following segments of the data file:

• Time between Tasks 1 and 2.

• Task 2.

• Time between Task 2 and 3.

• Task 3.

• Time between Tasks 3 and 4,

• Task 4.

• Time after Task 4.

8. Calculate the differences between the completion times of Task 2 and Task 1, and Task 4 and 
Task 3. Report these values in the Journal, and Table HP-  3  -L2.

Questions
1. Is there a difference between the changes in the subject’s skin conductance level (SCL) in Tasks

1 and 2? Is there a difference between the subject’s heart rate in Tasks 1 and 2? 

2. Did the subject take longer to complete Task 1 or Task 2? Did the color stimuli interfere with 
reading words?

3. Is there a difference between the changes in the subject’s skin conductance level (SCL) in Tasks
3 and 4? Is there a difference between the subject’s heart rate in Tasks 3 and 4? 

4. Did the subject take longer to complete Task 3 or Task 4? Did the word stimuli interfere with 
naming colors?

5. Did the subject take longer to complete Task 2 or Task 4? Did the word stimuli make color 
naming more difficult or did the color stimuli make reading words more difficult? Why is this 
so?

Predictions
1. What would happen if the order of the colors in the list of words for Task 2 (Reading Colored 

Words) was repetitive?

2. What would happen if the order of the colors in the list for Task 3 (Naming Colors of Symbols) 
was repetitive?

3. What would happen if the order of the colors in the list of words for Task 4 (Naming Colors of 
Words) was repetitive?

Human Psychophysiology – StroopEffect HP-3-11
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4. What would happen in Task 4 if the subject was a child who had not yet learned to read?

5. What would happen in Task 4 if the subject was just beginning to speak English?

Table HP-3-L2: Skin conductance levels, heart rates, and completion times during Tasks 1 
through 4.

Skin Conductance (µS) Heart Rate (BPM) Times (secs)

Task Max Min Mean Max-Min Max Min Mean Max-Min Completion
of Task Differential

Before 
Task 1

Task 1: 
Read in 
Black 
Print

Between 
Tasks 1 
and 2

Task 2: 
Read in 
Different 
Color

Between 
Tasks 2 
and 3

Task 3: 
Name 
Color of 
Symbol

Between 
Tasks 3 
and 4

Task 4: 
Name 
Color of 
Word

After Task
4 
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Aim: To determine the effect of words on the subject’s ability to name the location of a word in a 
frame.

Procedure
1. The subject should sit with his or her back to the computer monitor. The subject should rest the 

hand with the electrodes comfortably on his or her lap.

2. Instruct the subject that the object of the task is to name the position of the word in each frame 
on Table HP-  3  -L3 aloud, and as quickly as possible.

3. Type Task 5: Name Position of Same Word in the Mark box that is to the right of the Mark 
button. 

4. Click on the Record button located on the upper right side of the LabScribe Main window 
(Figure HP-  3  -L1). The signal should begin scrolling across the screen. Record until the skin 
conductance level of the subject has reached a stabile baseline.

5. Press the Enter key on the keyboard as soon as the subject begins naming the position of the 
word.

6. Type End in the Mark box.

7. Press the Enter key on the keyboard as soon as the subject has named the last position on Table 
HP-  3  -L3. Continue to record.

8. Type Task 6: Name Position of Different Words in the Mark box, as the subject relaxes for 1 to 
2 minutes.

9. Instruct the subject to name the position of the word in each frame on Table HP-3-L4 aloud, as 
quickly as possible. Press the Enter key on the keyboard as soon as the subject begins naming 
the position of the word.

10. Type End into the Mark box.

11. Press the Enter key on the keyboard as soon as the subject has named the last position on Table 
HP-  3  -L4. Continue to record as the subject relaxes for 1 to 2 minutes.

12. Click Stop to halt the recording.

13. Select Save in the File menu.

Data Analysis: Tasks 5 and 6
1. Scroll through the data file and locate the recording that was made before Task 5. 

2. Use the Display Time icons to adjust the Display Time of the Main window so that the segment 
before Task 5 can be viewed on the screen.

3. Use the same techniques used on the data from Exercises 1 and 2 to measure the maximum, 
minimum, and mean skin conductance levels and heart rate from the data recorded before Task 
5.

Human Psychophysiology – StroopEffect HP-3-13
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4. Transfer the values for these parameters to the Journal using either of the techniques described 
in the first analysis section. Record the values for these parameters on Table HP-  3  -L5.

5. Use the same techniques to measure and record these parameters for the other segments of 
Exercise 3:

• Task 5,

• Time between Tasks 5 and 6,

• Task 6,Time after Task 6.

6. Measure the task completion times for Tasks 5 and 6. Record the values for these times in the 
Journal and on Table HP-  3  -L.

7. Calculate the difference between the maximum and minimum skin conductance levels, and the 
maximum and minimum heart rates. Record these values in the Journal, and Table HP-3-L5.

8. Calculate the differences between the completion times of Task 6 and Task 5. Report this value 
in the Journal, and on Table     HP-  3  -L5.

9. Select Save in the File menu.

Table HP-3-L5: Skin conductance levels, heart rates, and completion times during Tasks 5 and 6.

Skin Conductance (µS) Heart Rate (BPM) Times (secs)

Task Max Min Mean Max-Min Max Min Mean Max-Min Completion
of Task Differential

Before 
Task 5

Task 5: 
Name 
Same 
Direction

Between 
Tasks 5 
and 6

Task 6: 
Name 
Different 
Direction

After Task
6
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1. Is there a difference between the changes in the subject’s skin conductance level (SCL) in Tasks

5 and 6? Is there a difference between the subject’s heart rate in Tasks 5 and 6? 

2. Did the subject take longer to complete Task 5 or Task 6? Did the word stimuli interfere with 
naming directions?

Exercise 4: Additional interferences
Aim: To perform another test for interference between associative tasks.

Procedure
1. Find or devise an additional test for interference between tasks that seem to be associated. 

• Additional tests to demonstrate the “Stroop Effect” can be found by searching the 
Internet. You should be able to find tests that demonstrate other interferences: word 
stimuli on counting, word stimuli on naming pictures, and audio stimuli on naming. 

• Devise your own test on tasks that think are associated.

• Test one of the predictions made earlier in this experiment.

2. Record the same parameters, skin conductance level and heart rate and test completion time, 
used in Exercises 1, 2, and 3.

Data Analysis
1. Use the same methods employed in Exercises 1, 2, and 3 to analyze the data collected from this 

additional Stroop test.

2. Construct a table to display the results of your test. Share these results with other groups in your
class.

3. Compare the strength of interference of this additional stimuli to the strength of interference of 
the additional stimuli used by other groups of students.

4. Compare the strength of interference of this additional stimuli to the strengths of interference 
demonstrated in Exercises 1, 2, and 3.
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Table HP-3-L1: Lists of colored words used in Exercises 1 and 2 of “The Stroop Effect”.

Task 1 Task 2 Task 3 Task 4

BLUE BLUE XXXX RED

GREEN GREEN XXXX BLUE

RED BLACK XXXX GREEN

GREEN BLUE XXXX BLUE

RED GREEN XXXX BLACK

RED RED XXXX BLUE

BLUE GREEN XXXX GREEN

GREEN RED XXXX RED

BLUE BLUE XXXX GREEN

BLACK BLACK XXXX RED

BLUE BLUE XXXX BLUE

BLACK GREEN XXXX BLACK

BLUE RED XXXX BLUE

GREEN BLUE XXXX GREEN

BLUE GREEN XXXX BLACK

GREEN BLUE XXXX BLUE

BLACK BLACK XXXX RED

BLUE BLUE XXXX GREEN

GREEN BLACK XXXX RED

RED BLUE XXXX BLUE

BLACK RED XXXX GREEN

BLUE GREEN XXXX BLACK

RED RED XXXX BLUE

GREEN GREEN XXXX GREEN

RED RED XXXX RED
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Table HP-3-L3: Frames with identical words and positions used in Exercise 3 of Experiment 38.

UP LEFT
DOWN

LEFT RIGHT 

LEFT UP RIGHT 
DOWN

UP

UP

DOWN
RIGHT UP LEFT

DOWN
LEFT UP RIGHT DOWN

LEFT RIGHT 
DOWN

UP RIGHT 

Table HP-3-L4:Frames with different words and positions used in Exercise 3.

UP LEFT DOWN LEFT RIGHT 

LEFT UP RIGHT DOWN UP

UP DOWN RIGHT UP
LEFT

DOWN LEFT UP RIGHT DOWN

LEFT
RIGHT

DOWN UP RIGHT
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